
Cloud Assessment
Software Version: 1.01

Windows and Linux Operating System

Report Editor

Document Release Date: January 2018

Software Release Date: January 2018



Legal notices

Warranty
The only warranties for Seattle SpinCo, Inc. and its subsidiaries (“Seattle”) products and services are set
forth in the express warranty statements accompanying such products and services. Nothing herein should
be construed as constituting an additional warranty. Seattle shall not be liable for technical or editorial errors
or omissions contained herein. The information contained herein is subject to change without notice.

Restricted rights legend
Confidential computer software. Except as specifically indicated, valid license from Seattle required for
possession, use or copying. Consistent with FAR 12.211 and 12.212, Commercial Computer Software,
Computer Software Documentation, and Technical Data for Commercial Items are licensed to the U.S.
Government under vendor's standard commercial license.

Copyright notice
© Copyright 2017 EntIT Software LLC, a Micro Focus company.

Trademark notices
Adobe™ is a trademark of Adobe Systems Incorporated.

Microsoft® and Windows® are U.S. registered trademarks of Microsoft Corporation.

UNIX® is a registered trademark of The Open Group.

Documentation updates
The title page of this document contains the following identifying information:

l Software Version number, which indicates the software version.
l Document Release Date, which changes each time the document is updated.
l Software Release Date, which indicates the release date of this version of the software.

To verify you are using the most recent edition of a document, go to
https://softwaresupport.hpe.com/manuals.

To check for new versions of software, go to https://www.hpe.com/software/entitlements. To check for recent
software patches, go to https://softwaresupport.hpe.com/patches.

You will also receive updated or new editions if you subscribe to the appropriate product support service.
Contact your Micro Focus sales representative for details.

For information and details about the products, services, and support that Micro Focus offers, contact your
Client Director.

Support
Visit the Micro Focus Software Support Online web site at https://software.microfocus.com/en-
us/software/customer-technical-support-services.

This web site provides contact information and details about the products, services, and support that Micro
Focus offers.

Micro Focus online support provides customer self-solve capabilities. It provides a fast and efficient way to
access interactive technical support tools needed to manage your business. As a valued support customer,
you can benefit by using the support web site to:

l Search for knowledge documents of interest
l Submit and track support cases and enhancement requests
l Manage software licenses
l Download new versions of software or software patches
l Access product documentation

Report Editor

Cloud Assessment (1.01) Page 2 of 61

https://softwaresupport.hpe.com/manuals
https://www.hpe.com/software/entitlements
https://softwaresupport.hpe.com/patches
https://softwaresupport.hpe.com/
https://softwaresupport.hpe.com/


l Manage support contracts
l Look up Micro Focus support contacts
l Review information about available services
l Enter into discussions with other software customers
l Research and register for software training

Most of the support areas require you to register as a Passport user and sign in. Many also require a support
contract.

To register for a Passport ID, go to https://cf.passport.softwaregrp.com/hppcf/login.do.

To find more information about access levels, go to
https://softwaresupport.hpe.com/web/softwaresupport/access-levels.

To check for recent updates or to verify that you are using the most recent edition of a document, contact
your Client Director.
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Chapter 1: Report Editor Guide
Welcome to theReport Editor User Guide. This guide explains how to use Report Editor as part of Micro
Focus Cloud Assessment (Micro Focus Cloud Assessment).

This guide contains the following chapters:

l Report Editor , on page 8
Provides an overview of themain features of Report Editor.

l Getting Started , on page 13
Describes the installation of themain features, and shows you how to create an reporting project in Report
Editor.

l Designing Reports , on page 20
Explains how to create, edit, and add data to reports usingReport Editor.

l Using DQL, on page 23
Shows how to use DQL to creates queries in Report Editor.

l Exploring the Database , on page 42
Shows how to setup and access your database in Report Editor.

l Deploying Reports , on page 48
Shows how to create and apply extensions to deploy reports created in Report Editor.

l Example: Failure Impact Report for the Reports Tab , on page 54
Demonstrates how to build the report shown in the Report Editor use case.

l Dialog Boxes , on page 57
Dialog boxes reference.

l Troubleshooting , on page 59
Tips for resolving common problems in Report Editor.
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Chapter 2: Report Editor 
Workbench includes Report Editor enabling you to create and deployment new reports easily and simply. The
relationship between Report Editor and the Cloud Assessment Reporting Service is shown in “Cloud
Assessment Reporting Framework”.

Cloud Assessment Reporting Framework

TIP:
Tip: Cloud Assessment Report Editor is an implementation of the Built-In Reporting Tool (BIRT), an
open source Eclipse-based reporting system. The Helpmenu includes the BIRT documentation. The
BIRT Report Developer Guide describes the general use of BIRT to create reports. The Report Editor
Guide adds to this by explaining how to use this functionality in conjunction with Cloud Assessment.

This chapter introduces Report Editor in the following sections:

l Overview , below
l User Interface , on the next page
l UseCases , on page 12

Cloud Assessment Workbench Suite
Cloud Assessment Workbench is a suite of editor tools enabling you to customize your deployment of Cloud
Assessment.

Cloud Assessment Workbench consists of the following editor tools, distributed as a single Eclipse
development platform:

l Customization Editor
Customizes the underlying System DataModel (SDM) within Micro Focus Cloud Assessment.

l Taxonomy Editor
Customizes the taxonomies used to categorize artifacts in Micro Focus Cloud Assessment.

l Assertion Editor
Customizes the conditions applied by your business policies within Micro Focus Cloud Assessment.

l Report Editor
Customizes report definitions for use with Micro Focus Cloud Assessment.

Overview 
Report Editor interacts with Cloud Assessment, enabling you to access existing report definitions, create
customized reports, and deploy them to the Cloud Assessment server.

To access, create, and deploy reports with Cloud Assessment, follow this process:
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1. Create a reporting project.
For details, see Configuring a Reporting Project , on page 16.

2. Create andmodify reports.
For details, see Designing Reports , on page 20.

3. Deploy your reports to Cloud Assessment.
For details, see Deploying Reports , on page 48.

4. Access your reports in Cloud Assessment.
For details, see:
l UseCases , on page 12
l Accessing Reports , on page 48
l Example: Failure Impact Report for the Reports Tab , on page 54
l Micro Focus Cloud Assessment User Guide

User Interface 
The default platform perspective is split into a number of views with menu options across the top, as
shown in image below.

Platform Perspective

The default platform perspective is split into a number of views as following:

l Project Explorer
The tree view of your reporting project. For details, see Project Explorer , on the next page.

l Data Explorer
The view of the data sources and data sets for a particular report. For details, see Data Explorer ,
below.

l Server Explorer
A list of Cloud Assessment servers connected toMicro Focus Cloud Assessment Workbench. For
details, see Server Explorer , on page 11.

l Editor Views
Themain area of the perspective contains report editor views. In this view you can edit the layout
and properties of your report definition. For details, see theBIRT Report Developer Guide, which you
can access from themenu by selectingHelp>Help Contents.

Data Explorer 
The Data Explorer displays the sources and sets of data used by the particular report you are working
with, as shown in the Data Explorer View.

Data Explorer View

Report Editor
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Data Explorer contains the following elements:

l Data Sources
Open the context menu and select New Data Source to access a database.
For details, see Adding a Data Source to a Report , on page 20.

l Data Sets
Open the context menu and select New Data Set to define the data used by the report.
For details, see Creating a Data Set , on page 21.

Project Explorer 
The Project Explorer, as shown below, is a view of the projects in your workspace and the report
definitions they contain. This view is also an interaction point with Cloud Assessment.

Project Explorer

Each project contains a set of report definitions and the Cloud Assessment library.

Each report definition contains the following sections:

l Overview
Double-click to open a properties editor view enabling you to change the name and description, and
tomark the report as Shared to all users or leave the report as user specific.

l Report Design
Double-click to open a layout editor view enabling you to change the appearance and content of the
report definition.

The Project Explorer contains additional context menu options enabling you to interact with a running
Cloud Assessment server. Right-click the project name or a particular report definition, and select
Cloud Assessment to view the options listed in “Project Context MenuOptions” and “Report
Definition Context MenuOptions”.

Project Context Menu Options

Option Function

Download
Reports

Import report definitions from Cloud Assessment. For details, see Importing Report
Definitions , on page 18.

Upload to
Server

Export a report to the default Cloud Assessment server. For details, see Deploying a
Report to Cloud Assessment , on page 49.

Update from
Server

Update report definitions from Cloud Assessment.

Remove
from Server

Delete reports from Cloud Assessment.

Upload To
Other

Export a report to a specified Cloud Assessment server.
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Option Function

Server

Build
Extension

Create a reporting extension for Cloud Assessment containing all the reports in your
project. For details, see Creating a Reporting Extension , on page 48.

Report Definition Context Menu Options

Option Function

Upload to
Server

Export a report to the default Cloud Assessment server. For details, see Deploying a
Report to Cloud Assessment , on page 49.

Update from
Server

Update report definitions from Cloud Assessment. For details, see Importing Report
Definitions , on page 18.

Remove
from Server

Delete the report from Cloud Assessment.

Upload To
Other
Server

Export a report to a specified Cloud Assessment server.

Build
Extension

Create a reporting extension for Cloud Assessment containing all the reports in your
project. For details, see Creating a Reporting Extension , on page 48.

Server Explorer 
The Server Explorer displays the Cloud Assessment servers connected toMicro Focus Cloud
Assessment Workbench, as shown in “Server Explorer View”. The functionality is shared by all the
Micro Focus Cloud Assessment Workbench editors.

Server Explorer View

Right-click a server in the Server Explorer to open the context menu described in “Server Explorer
Context MenuOptions”.

Server Explorer Context Menu Options

Option Function

New Server Add a server for downloading assertions and taxonomies (Assertion Editor,
Taxonomy Editor, and Customization Editor).

Remove
Server

Delete a server from the Server Explorer.

Download
Taxonomy

Download a taxonomy from a platform server (Taxonomy Editor and Customization
Editor).
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Option Function

Download
Assertion

Download assertions from a platform server (Assertion Editor).

Download
Report

Download reports from a reporting server (Report Editor).

Properties View and edit the server name, URL, username, and password.

Use Cases 
Cloud Assessment enables you to add custom BIRT reports created in Report Editor to the Reports
tab.

To create and use a custom BIRT report in Cloud Assessment:

1. Create a new report definition.
For details, see Creating a Report Definition , on page 20.

2. Add a data source for the report.
For details, see Adding a Data Source to a Report , on page 20.

3. Create a data set for the report,
For details, see Creating a Data Set , on page 21.

4. Design your report layout.
For details, see theBIRT Report Developer Guide, which you can access from themainmenu by
selectingHelp>Help Contents.

5. Deploy the report to Cloud Assessment.
For details, see Deploying a Report to Cloud Assessment , on page 49.

6. Add the report to the Cloud Assessment Reports Tab.
For details, see the "Custom Birt Reports" section of theMicro Focus Cloud Assessment User
Guide.

For a step-by-step walkthrough demonstrating this use case, see Example: Failure Impact Report for
the Reports Tab , on page 54.
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Chapter 3: Getting Started 
Cloud Assessment is distributed with a set of predefined reports and various ways to access them.

Report Editor provides amechanism to customize these existing reports, and also enables you to create new
report definitions from scratch.

This chapter describes the setup of Report Editor in the following sections:

l Installing Cloud Assessment Workbench, below
l SSLConfiguration, on page 15
l Installing a Report Development Environment , on page 15
l Configuring a Reporting Project , on page 16

Installing Cloud Assessment Workbench
Cloud Assessment is an Eclipse development platform distributed as a zip file, microfocus-
cloudassessment-workbench-1.01-win64.zip.

NOTE:
Cloud Assessment requires Java SE Development Kit (JDK) 1.8.0 (64 bit version only) or higher. You
must include the path to this version of the JDK in the JAVA_HOME environment variable.

(missing or bad snippet)
To Start Cloud Assessment:

l ExecuteWB_HOME/workbench/start.exe.
The first time you start Micro Focus Cloud Assessment Workbench, the welcome screen opens.

Screenshot: Workbench Welcome Screen

Select one of the options to open one of the editor tools, start a new editing project, or view the documentation
set.
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You can return to the welcome screen from any of the editor tools by selectingHelp > Welcome from
themenu options.

TIP:
By default, Micro Focus Cloud Assessment Workbench runs in 'normal' mode which prevents
users from uploading system taxonomies (IDs start with
uddi:systinet.com:soa:model:taxonomies) and the Report Editor .rptlibrary file to Micro
Focus Cloud Assessment servers. If you need to work with system taxonomies or want to
upload the .rptlibrary file you can switchMicro Focus Cloud Assessment Workbench into
'admin' mode.

CAUTION:
Be extremely careful when working with system taxonomies, Micro Focus Cloud Assessment
uses some hard-coded values from system taxonomies. Changing or removing themmay
cause errors.

To Switch Micro Focus Cloud Assessment Workbench to Admin Mode

1. Open WB_HOME/configuration/config.ini with a text editor.
2. Add mode=admin to config.ini.
3. Restart Micro Focus Cloud Assessment Workbench.

TIP:
Micro Focus Cloud Assessment is memory-intensive. If you experience performance issues,
Micro Focus recommends increasing thememory allocation.

To increase the memory allocation for Micro Focus Cloud Assessment:

1. Open WB_HOME/workbench/start.ini for editing.
2. Set these new values:

l -Xms128m

l -Xmx1024m

3. Save your changes.
4. Restart Micro Focus Cloud Assessment Workbench.

TIP:
Micro Focus Cloud Assessment downloads fromMicro Focus Cloud Assessment may time
out. If you experience issues, Micro Focus recommends increasing the time out.

To increase the time out for Micro Focus Cloud Assessment:

1. Open WB_HOME/workbench/start.ini (or eclipse.ini for stand-alone installation) for editing.
2. Set the new value:

-Dorg.cloudassessment.platform.rest.Client.timeout=200000

The value is in milliseconds with a default value of 120000 (2minutes).
3. Save your changes.
4. Restart Micro Focus Cloud Assessment Workbench.
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TIP:
Workbenchmay fail to store saved credentials of servers. In such cases, Micro Focus
recommends clearing the secure storage.

To reset the secure storage for Cloud Assessment server credentials:

1. In Cloud Assessment, go toWindows > Preferences > General > Security > Security
Storage > Contents tab.

2. Click root nodeDefault Secure Storage and then click Delete button.

3. Restart theWorkbench.

SSL Configuration
By default, Micro Focus Cloud Assessment Workbench trusts all Micro Focus Cloud Assessment
server certificates. Youmay want Micro Focus Cloud Assessment Workbench to verify Micro Focus
Cloud Assessment certificates.

To Verify Micro Focus Cloud Assessment Server Certificates:

l Add the following options to WB_HOME/workbench/start.ini:

-Dcom.microfocus.cloudassessment.security.ssl.verifyCert=true
-Djavax.net.ssl.trustStore=USER_TRUSTSTORE
-Djavax.net.ssl.trustStorePassword=TRUSTSTORE_PASS
-Djavax.net.ssl.trustStoreType=TRUSTSTORE_FORMAT

If Micro Focus Cloud Assessment is configured for 2-way SSL, youmust provideMicro Focus Cloud
Assessment Workbench certificates toMicro Focus Cloud Assessment.

To Provide Micro Focus Cloud Assessment Workbench Client Certificates to Micro Focus
Cloud Assessment:

l Add the following options to WB_HOME/workbench/start.ini:

-Djavax.net.ssl.keyStore=USER_KEYSTORE
-Djavax.net.ssl.keyStorePassword=KEYSTORE_PASS
-Djavax.net.ssl.keyStoreType=KEYSTORE_FORMAT

Installing a Report Development Environment 
This section describes a setup to develop and test reports on a single computer.

For supported platforms, see readme.txt in the installation folder.

A typical report development environment consists of the following:

l PC or notebook with at least 2GB RAM and at least 5GB free disk space
l Windows XP orWindows 2000
l Oracle eXpress Edition (XE)
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For deployment details, seeOracle XE Account Setup , below.
You do not need to install XE if you have dba-level access to deployed Cloud Assessment
environment using Oracle 10g.

l Java 1.5_9 or higher
For deployment details, see Java Environment Setup , below.

l Cloud Assessment deployed to JBoss
For details, seeMicro Focus Cloud Assessment Installation and Deployment Guide.
You do not need to install Cloud Assessment if you have access to a test environment.

l Oracle Developer
Micro Focus Software recommends this tool for tuning SQL queries.

Java Environment Setup 
After installing Java, youmust set an environment variable, JAVA_HOME.

To set the JAVA_HOME environment variable:

1. InWindows, click throughControl Panel > System > Advanced > Environment Variables.
The Environment Variables dialog box opens.

2. In the User Variables section, click New.
3. Input Variable Name, JAVA_HOME, and set Variable Value to the installation folder for Java.
4. Click OK to exit each dialog box.

Oracle XE Account Setup 
If you install Oracle XE, youmust create a user account.

To create an Oracle XE account:

1. Open the XE web console and log on as the system user.
2. Create a new user, platform, with the password changeit, then grant the new user all available

privileges.

Configuring a Reporting Project 
To use Report Editor with Cloud Assessment, youmust create or import a project, and import any
report definitions you want to modify.

These procedures are described in the following sections:

l Creating a Reporting Project , on the next page
l Importing a Reporting Project , on page 18
l Importing Report Definitions , on page 18
In addition you can configure Report Editor in the following ways:
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l Rebranding Cloud Assessment Reports , on the next page
l Configuring theModel , on page 19
l Configuring the Reporting Logging Level , on page 19

Creating a Reporting Project 
The Report Editor organizes your work into project folders in your workspace.

To create a reporting project:

1. Do one of the following:
l In theMicro Focus Cloud Assessment WorkbenchWelcome page, select Create Report
Project.

l From themenu, select File > New > Report Project.
l Press Alt+Shift+N, and then press R. ExpandCloud Assessment, select Report Project,
and then click Next.

The New Report Project Wizard opens.
2. In the New Report Project dialog box, enter the following parameters:

Parameter Definition

Project Name The name of your report project.

Create from
Existing
Extension

Select this option if you want to create a new project from a previous report
extension. If selected, input the path or browse for the location of the report
extension.

Use Default
Location

If selected, Report Editor stores the project in your default workspace. If
unselected, input the path or browse for an alternative workspace.

3. Do one of the following:
l Select Create a New Server, and then click Next.
Continue to Step 4.

l Select Use an Existing Server, select the server from the list and input its credentials, and
then click Next.
Continue to Step 5.

4. In the New Server dialog box, add the parameters you require, and then click Next.
For parameters descriptions, see New Report Project Wizard: New Server , on page 58.

5. If needed, in the New Data Source dialog box, click Manage Drivers to add a JDBC driver.
For details, see Adding a JDBC Driver , on page 42.

6. In the New Data Source dialog box, add the parameters you require.
For parameters descriptions, see New Report Project Wizard: Default Library Configuration -
Create a new data source , on page 58.
If your database server is running, click Test Connection to check if your settings are correct.

7. Click Next to set project options.
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8. Do one of the following:
l To create a generalized reporting project, click Finish and exit the wizard.
l To create a project associated with a specific report category, click Next and continue this
procedure.
The Cloud Assessment server must be running to access report definitions.

9. Select a report category for your reporting project, and then click Next.
10. Select report definitions from the selected category to download to the Report Editor, and then

click Finish.

Importing a Reporting Project 
You can import a reporting project created elsewhere into your Micro Focus Cloud Assessment
Workbench installation.

To import a reporting project:

1. Copy the project folder to your local files ystem.
2. From themenu, select File > Import.

The Import dialog box opens.
3. ExpandGeneral and select Existing Projects into Workspace.
4. UseBrowse, select the project from your local file system, and then click OK.
5. Click Finish to import the reporting project.

Importing Report Definitions 
The Cloud Assessment server contains all the report definitions for Cloud Assessment. Tomodify
existing reports, youmust import their definitions from the Cloud Assessment server.

To import Cloud Assessment report definitions:

1. In the Project Explorer, open the context menu for the project, and do one of the following:
l Select Cloud Assessment > Download Reports to import from the current Cloud
Assessment server.

l Select Import > Report, and then select a reporting server.
The Cloud Assessment server must be running.

2. Select the report category, and then click Next.
3. Select the report definitions you require, and then click Finish.

Rebranding Cloud Assessment Reports 
By default, most Cloud Assessment reports include aMicro Focus branded logo. You can replace this
image with your own company-specific image.

To rebrand Cloud Assessment reports:
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1. Open s2_default.rptlibrary for editing.
2. In the Outline view, expand Embedded Images.
3. Open the context menu for logoHP.gif and select Delete.
4. Open the context menu for Embedded Images, and select New Embedded Image.
5. Upload your new company branded image whichmust be named logoHP.gif.
6. Save s2.default.rptlibrary.
7. Redeploy all reports that use this image to Cloud Assessment. For details, see Deploying

Reports , on page 48.

Configuring the Model 
Cloud Assessment divides the architecturemodel into a public and systemmodel. By default, Report
Editor accesses the public model whichmeans that you can only create reports that access these
public artifact types.

If you need to access system artifact types in your reports then youmust modify the library.

To Extend the Reporting Model to access System Artifacts:

1. Open the s2_default.rptlibrary file in your workspace in a text editor.
2. Locate the oda-data-source element with name="dqlDatabase in the file.
3. Edit the property name="odaURL" element, adding |model=sys to the property value.
4. Save s2_default.rptlibrary.

Configuring the Reporting Logging Level 
Cloud Assessment reporting uses the BIRT engine for report execution which uses standard JDK
logging with root logger org.eclipse.birt. You can configure the logging in that sameway as any
other component that uses JDK logging, typically using a configuration file passed with the -
Djava.util.logging.config= switch.

The default logging level is set to SEVERE, but this is overidden if you specify the logging level in a
logging configuration file..

For details about JDK logging, see http://java.sun.com/j2se/1.5.0/docs/guide/logging/overview.html.
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Chapter 4: Designing Reports 
This chapter describes the functionality of Report Editor in conjunction with Cloud Assessment. The standard
functionality of Report Editor is described in theBIRT Report Developer Guide, which you can access from
themainmenu by selectingHelp>Help Contents.

This chapter contains the following sections:

Creating a report:

l Creating a Report Definition , below
l Adding a Data Source to a Report , below
l Creating a Data Set , on the next page
l Designing a Report Layout , on page 22
l Shared and User-Specific Reports , on page 22
l Modifying Existing Report Definitions , on page 22

Creating a Report Definition 
The first step in defining a report is to create the report definition.

To create a report definition:

1. Select File > New > Report from themenu.
2. Input a name and description for the report, and then click Next.
3. Select the project folder, and then click Finish to create the report definition.
4. Press Ctrl+S to save the report definition.
See Step 1 of Example: Failure Impact Report Layout , on page 55 for an example of this procedure.

Adding a Data Source to a Report 
By default, new reports contain DQL and SQL data sources setup during project creation. If you need to use a
different one, youmust add it to the report.

Cloud Assessment only supports the default datasources. Reports using user-created datasources work
within Report Editor but do not display when the report executes on the Cloud Assessment server.

To add a data source to a report:

1. Open the report definition editor view.
2. In the Data Explorer, open the Data Sources context menu and select New Data Source.

The New Data Source dialog box opens.
3. Do one of the following:

l To add a datasource for DQL queries, select DQL JDBC Data Source.
l To add a datasource for SQL queries, select JDBC Data Source..
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Click Next.
4. If required, in the Data Source dialog box, click Manage Drivers to add a JDBC driver (the DQL

driver is pre-installed and there should never be a requirement to add one.
For details, see Adding a JDBC Driver , on page 42.

5. In the Data Source dialog box, add the parameters you require.
For parameter descriptions, see New Report Project Wizard: Default Library Configuration -
Create a new data source , on page 58.
If your database server is running, click Test Connection to check if your settings are correct.

6. Click Finish to add the data source to your report.
7. Press Ctrl+S to save your changes to the report definition.

Creating a Data Set 
Each report is associated with one or more queries that each return a data set.

To create a data set:

1. From the Report Design perspective, open the report definition view for the report requiring the
new data set.
If you need to use an alternative data source, see Adding a Data Source to a Report , on the
previous page.

2. In the Data Explorer, open the Data Sets context menu, and select New Data Set.
TheNew Data Set dialog opens.

3. In the New Data Set dialog box, add the parameters you require.
For parameters descriptions, see New Data Set , on page 57.

4. Click Next to open theQuery dialog box.
5. Do one of the following:

l Copy a query from your development tool to the query editor.
Skip to Step 8.

l Create your query in Report Editor as described in Step 6 to Step 7.
6. UseSchema (SQL only), Filter, and Type, and then click Apply Filter to focus on the data you

require in Available Items.
For SQL queries, Micro Focus Cloud Assessment Workbench limits the amount of data collected.
To change the settings, see Changing the Data Collection Settings , on page 43.

7. Browse Available Items to find the data items you require. Drag and drop items from Available
Items to the query editor and construct your query.
For portability to different Cloud Assessment installations using different schemas, remove the
schema name from the variables in your query if your database schema does not require them.

8. Click Finish to add the data set to the report definition.
9. Press Ctrl+S to save your changes.
For details about writing DQL queries, see Using DQL, on page 23.
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For details about the database structure and writing SQL queries, see Exploring the Database , on page
42.

For an example of this procedure, see Example: Failure Impact Data Set , on page 54.

NOTE:
If possible, use only one dataset per report definition. If you needmore datasets in one report
(for example, multiple properties in one table row), use JavaScript to build one table.

Designing a Report Layout 
TheBIRT Report Developer Guide contains all the information required to design the layout and content
of your reports. Select Help > Help Contents to view the guides included with Micro Focus Cloud
Assessment Workbench.

For an example, see Example: Failure Impact Report Layout , on page 55.

Shared and User-Specific Reports 
The Report Editor enables you to determine the security of report output. A report can bemarked as
shared to show the same data to all users or not shared. If a report is not shared, then each user only
sees the data they have read permission for in the report output.

The default value for a new report is shared.

To mark a report as shared or user-specific:

1. In theProject Explorer, expand the report you want to categorize and double-click Overview to
open a view of the report definition.

2. TheGeneral Information section displays a Shared check-box.
Select Shared to show the same report output to all users. De-select Shared to make the report
output restricted according to the user read permissions.

3. Press Ctrl+S to save your changes.

Modifying Existing Report Definitions 
Report definitions that already exist in Cloud Assessment can bemodified.

Procedure 5. To modify existing report definitions:

1. Import the report definition.
For details, see Importing Report Definitions , on page 18.

2. To open the report definition, in the Project Explorer, double-click the report definition rptdesign.
3. Make your modifications, as described in Creating a Report Definition , on page 20.
4. Press Ctrl+S to save your changes.
5. Redeploy the report definition to Cloud Assessment.

For details, see Deploying a Report to Cloud Assessment , on page 49.
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Chapter 5: Using DQL
The DQL query language provides a simple query solution for the System DataModel (SDM). It enables you
to query all aspects of themodel – artifacts, properties, relationships, governance, and compliance.

This chapter describes DQL in the following sections:

l Introduction to DQL, below
l DQLReference, on page 31
l DQLwith 3rd Party Products, on page 39

Introduction to DQL
DQL is an SQL-like language that enables you to query the repository of artifacts in Micro Focus Cloud
Assessment defined by the SDMmodel. DQL preserves SQL grammar, but uses artifacts instead of tables,
and artifact properties instead of table columns. As DQL is based on SQL you can apply your SQL knowledge
to DQL.

A simple example is to return the name and description of all business service artifacts.

select name, description
from businessServiceArtifact

In Micro Focus Cloud Assessment, you can use DQL queries in the following use cases:

l To create reports in Cloud Assessment Report Editor.
l To customize pages of the Cloud Assessment user interface. For details, see "UI Customization" "UI
Customization" in the Administration Guide

l You can also use DQL in any SQL designer using the DQL JDBC driver. For more details, see DQL in SQL
Designers, on page 41

The following sections contain DQL examples:

l Artifact Inheritance, on the next page
l Categorization Properties, on the next page
l Complex Properties, on page 25
l Embedding SQLQueries, on page 26
l FixingMultiple Properties, on page 27
l Modifiers, on page 27
l Primitive Properties, on page 27
l Relationships, on page 28
l Virtual Properties, on page 30
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Artifact Inheritance
Artifacts in Cloud Assessment form a hierarchy defined by the SDMmodel. Artifacts lower in the
hierarchy inherit properties from higher abstract artifact types. artifactBase is the root abstract
artifact type in the SDM hierarchy. All other artifacts are below it in the hierarchy and inherit its
properties. You can query abstract artifacts and return a result set from all the instances of artifact
types lower in the hierarchy.

Property groups function in a similar way, querying a property group returns results from all artifact
types that inherit properties from the group.

The following query returns results from all implementation artifacts; SOAP Services, XML Services,
andWeb Applications.

select name, serviceName
from implementationArtifact

Notice that in this query, serviceName is a specific property of SOAP Service artifacts. In the result
set, name is returned for all implementation artifacts but serviceName is only returned for SOAP
service artifacts. For other implementation types, the serviceName is NULL.

CAUTION:
Different artifact types may define the same properties with different cardinalities. In cases
where two artifact types define the same property with different cardinality, querying a shared
parent abstract artifact for these properties may fail. Examples that fail includeSELECT
environment FROM artifactBase andSELECT accessPoint FROM artifactBase.

Categorization Properties
Categorization properties are a special case of complex properties.

Categorization properties have the following sub-properties:

l val - machine readable name of the category.
l name - human readable name of the category.
l taxonomyURI - identifies the taxonomy defining the category set.
Note: taxonomyURI is not defined for named category properties.

Micro Focus Cloud Assessment uses categorization properties in the following ways:

l Named category properties (for example, business service criticality).
The following query returns the names, descriptions, and versions of all business service artifacts
which are categorized using the named criticality categorization property with a high failure impact.

select name, description, version
from businessServiceArtifact
where criticality.val =

'uddi:systinet.com:soa:model:taxonomies:impactLevel:high'

Note: taxonomyURI is not defined for named category properties. The name of the category
property implies the taxonomy.

l categoryBag
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categoryBag is a complex property that includes sub-property categories which is a categorization
property and categoryGroups. categoryGroups also contains categorization sub-property
categories and a taxonomyURI defining themeaning of the group. Micro Focus recommends
querying _category instead of categoryBag to ensure that all categories are queried.
The following query returns the names, descriptions, and versions of all business service artifacts
which are categorized by the Gift certificate category (14111608) of the
uddi:uddi.org:ubr:categorization:unspsc taxonomy.

select name, description, version
from businessServiceArtifact
where categoryBag.categories.taxonomyURI =

'uddi:uddi.org:ubr:categorization:unspsc'
and categoryBag.categories.val = '14111608'

l identifierBag
identifierBag is a complex property similar to categoryBag that includes sub-property
categories. identifierBag does not contain the categoryGroups subproperty. Micro Focus
recommends querying _category instead of identifierBag to ensure that all categories are
queried.

l _category
This generic categorization property holds all categorizations from categoryBag, identifierBag,
and all named categorization properties from the given artifact type.
The following query returns the names, descriptions, and versions of all business service artifacts
which are categorized with a high failure impact.

select name, description, version
from businessServiceArtifact
where _category.val =

'uddi:systinet.com:soa:model:taxonomies:impactLevel:high'
and _category.taxonomyURI =

'uddi:systinet.com:soa:model:taxonomies:impactLevel'

CAUTION:
When you use the generic _category property youmust specify the taxonomy using the _
category.taxonomyURI sub-property. When you use a named categorization property the
taxonomy is implicitly known and does not need to be specified.

Complex Properties
Complex properties are composed of one or more single or multiple-valued sub-properties (for example,
address contains sub-properties addressLines in multiple cardinality, country in single cardinality, and
so on. The sub-property addressLines is also a complex sub-property, containing a value and
useType.). It is only possible to query the sub-property components of primitive types. Components of
sub-properties are separated by . (in MS Access you can use $ as a separator).

select address.addressLines.value, address.country
from personArtifact
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where address.city = 'Prague'

For a full reference of all complex properties in the default SDM, see "System DataModel""System
DataModel" in theReferenceGuide.

Embedding SQL Queries
DQLworks with SDM entities (artifacts and properties) only and cannot directly access database
tables. In some cases it is necessary to obtain values from outside the SDM (for example, system
configuration). You can use an SQL subquery in a NATIVE clause of a DQL query. By default, DQL
expects SQL to return an unnamed single column of values.

The following example returns business services owned by the administrator using the name defined
during installation:

select name,description, version
from businessServiceArtifact
where _owner in (

native {select svalue from systemConfiguration
where name='shared.administrator.username'})

You can use NATIVE clauses instead of expressions, as a condition inWHERE clauses, as a column
in SELECT clauses, and as a artifact reference in FROM clauses. For details, see DQLGrammar, on
page 34 .

If you use a NATIVE clause to formulate part of a FROM clause, youmust specify parameters to bind
columns defined by SQL to properties used by DQL.

Each parameter consists of the following:

l The property name defines how DQL addresses columns returned from the NATIVE SQL statement.
l The property type whichmay be returned by themetadata of a column is optional and if not specified
is assumed to be a text string.

The parameters are enclosed in brackets in the native clause, delimited by commas, and the type is
separated from the name using whitespace.

The following example shows a query with NATIVE SQL in a DQL FROM clause.

select B.p_id, B.s_val, A.name, B.state_index
from (

native(s_val, s_name, state_index integer, p_name, p_id)
{select S.val as s_val, S.name as s_name, S.state_index as state_index,

P.name as p_name, P.id as p_id
from rylf_state S, rylf_process P
where S.fk_rylf_process=P.id and P.name='Application Lifecycle'}) B

left join artifactBase A on A._currentStage.val = B.s_val
order by B.p_id, B.state_index

The NATIVE statement returns the following columns; s_val, s_name, p_name, and p_id of type
String, and state_index of type Integer.

Note: Native clauses can not contain variables (? or :<variable>).
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Fixing Multiple Properties
Consider a business service with keywords, 'Finance' and 'Euro'. The intuitive query for finding a 'Euro
Finance' service is as follows:

select name, description, version
from businessServiceArtifact b
where b.keyword.val = 'Finance'

and b.keyword.val = 'Euro'

This query does not work as a single instance of keyword can never be both 'Finance' and 'Euro'

The solution is to fix instances of multiple properties as shown in the following query:

select name, description, version
from businessServiceArtifact b, b.keyword k1, b.keyword k2
where k1.val = 'Finance'

and k2.val = 'Euro'

Modifiers
Modifiers define primary sets of objects (artifacts and their revisions) to query. If nomodifier is
specified, the last revisions of undeleted artifacts for which the user has read access are queried.

The followingmodifiers are available:

l Revision relatedmodifiers (mutually exclusive):
o all_rev - queries all revisions of artifacts.
o last_approved_revision - queries the last approved revisions of artifacts.

l Security relatedmodifiers (mutually exclusive):
o my - queries artifacts belong to the user.
o writable - queries artifact the user has write permission for.
o no_acl - queries all artifacts regardless of security.

l Other modifiers:
o include_deleted - queries all instances, including deleted artifacts.

You can usemultiple comma-separatedmodifiers.

The following query returns all business services that you own that aremarked as deleted.

select b.name, b.version, b.keyword.name
from businessServiceArtifact b (my, include_deleted)
where _deleted = '1'

Primitive Properties
Primitive properties are simple properties, such as numbers, characters, and dates, that may occur
once or multiple times for an artifact depending on the cardinality as defined in the SDM.
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For example, in the SDMModel, each person is represented by a person artifact. The person artifact
includes a name property with single cardinality and an email property with multiple cardinality.

The following query returns the name and all emails for each person in the repository.

select name, email
from personArtifact

Instances of primitive properties with multiple cardinality are all returned as comma separated values.
For example, all the emails for a person return as a concatenated, comma-separated string. If there is
no instance of the property for an artifact, a null value is returned.

The following query returns the name, description, and version of all business service artifacts whose
version is 2.0.

select name, description, version from businessServiceArtifact where version = '2.0'

NOTE:
By default, DQL queries return the latest revisions of artifacts unless you specify revision
modifiers. For details, seeModifiers, on the previous page.

Relationships
A relationship is a special kind of complex property pointing to another artifact. Micro Focus Cloud
Assessment uses relationships to join artifacts.

The following queries are semantically identical and return all business services and the contact details
of their provider. These queries do not return business services that do not have providers.

l The following query is an example of anSQL92-like join which uses the USING clause.

select b.name, b.version, b.keyword.name, p.name as contact, p.email
from businessServiceArtifact b
join personArtifact p using provides

The relationship property provides leads from person artifacts to business service artifacts is
specified after the using keyword.

l The following query is an example of anSQL92-like join which uses the ON clause.

select b.name, b.version, b.keyword.name, p.name as contact, p.email
from businessServiceArtifact b
join personArtifact p on bind(provides)

The relationship property provides leads from person artifacts to business service artifacts is
specified with the bind predicate in the WHERE clause.

l The following query is an example of an old-style join which uses the BIND predicate.

select b.name, b.version, p.name as contact, p.email
from businessServiceArtifact b, personArtifact p
where bind(p.provides, b)

The BIND predicate specifies that the provides relationship of the person artifact points to business
service artifacts.
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The following query also returns all business services and the contact details of their provider. This
query is an example of a LEFT JOIN. The LEFT JOIN extends the previous queries by also returning
business services that do not have providers.

select b.name, b.version, p.name as contact, p.email
from businessServiceArtifact b
left join personArtifact p using provides

Each relationship has the following sub-properties which you can query:

l rType - the SDMQNames of the relationship type.
l useType - the values of the useType relationship property
l target - the UUIDs of the artifact the relationship points to (deprecated).
It is possible to specify a particular provider type using useType. The following queries return all
business services and their contact details where the provider is an architect.

select b.name, b.version, p.name as contact, p.email
from businessServiceArtifact b, personArtifact p
where bind (p.provides, b)

and p.provides.useType = 'architect'

select b.name, b.version, p.name as contact, p.email
from businessServiceArtifact b
join personArtifact p on bind(p.provides, b)

and p.provides.useType = 'architect'

It is possible to traverse several relationships using several old-style joins or SQL-92-like join clauses
in the same query. The following example queries business services in applications, which are also
part of a project.

select b.name, b.description, a.name as Application, p.name as Project
from businessServiceArtifact b
join hpsoaApplicationArtifact a using hpsoaProvidesBusinessService
join hpsoaProjectArtifact p using contentRelationshipType

In cases where artifacts may be joined by multiple properties, you can use a generic _relation
property together with the additional rType condition.

select A.name as A_name, B.name as B_name
from hpsoaApplicationArtifact A left join artifactBase B on bind(A._relation)

and A._relation.rType in (
'{http://systinet.com/2005/05/soa/model/property}

hpsoaProvidesBusinessService',
'{http://systinet.com/2005/05/soa/model/property}r_providesBusinessProcess'

);

You can use the target relationship sub-property to bind the source and target of a relationship.

select b.name, b.version, p.name as contact, p.email
from businessServiceArtifact b, personArtifact p
where p.provides.target = b._uuid

Caution: The target property and this style of comparison is deprecated and its use is not
recommended. Use the bind predicate instead.
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Virtual Properties
DQL defines virtual properties, that are not defined by the SDM. Micro Focus Cloud Assessment
stores or calculates these properties enabling DQL to query meta information about artifacts. These
virtual properties provide information about lifecycle, compliance, domains, etc.

The following example returns lifecycle details from the last approved revisions of all business service
artifacts, ordered by lifecycle stage.

select name, _lastApprovedStage.name Stage, _revision
from businessServiceArtifact(last_approved_revision)
order by Stage

The following example returns the name and compliance status of last approved revisions of all
business services which a compliance status of at least 80%.

select b.name, b._complianceStatus
from businessServiceArtifact b (last_approved_revision)
where b._complianceStatus >= 80

Micro Focus Cloud Assessment repository content exists within a domain structure where each artifact
exists within only one domain. The default functionality of DQL queries all domains but Micro Focus
Cloud Assessment provides virtual properties enabling you to query artifacts within a particular domain.
The following example returns business service names and the domain details of all business service
artifacts that exist within the EMEA domain.

select A.name, A._domainId, A._domainName
from businessServiceArtifact A
where A._domainId="EMEA"

DQL provides the followingmacros for querying within domain hierarchies:

l #SUBDOMAINS('domainId')
Queries the specified domain and all its sub-domains.

l #SUPERDOMAINS('domainId')
Queries the specified domain and all its parent domains.

The following query returns all business services in the EMEA domain and any of all of its sub-
domains.

select A.name
from businessServiceArtifact A
where A._domainId in #SUBDOMAINS('EMEA')

The following query returns the name and virtual properties artifactTypeName and owner from the latest
revisions of consumer properties (the property group for all consuming artifact types).

select name, _artifactTypeName, _owner
from consumerProperties

For details of all virtual properties, see Properties in DQL, on the next page.

Report Editor
Chapter 5: Using DQL

Cloud Assessment (1.01) Page 30 of 61



DQL Reference
This section provides a reference to properties and DQL grammar in the following sections:

l Properties in DQL, below
l DQL and SQL, on page 34
l DQLGrammar, on page 34

Properties in DQL
Artifact (property group) properties hold values whichmay be queried in DQL expressions.

DQL recognises the following properties:

l SDM Properties
Properties defined in the SDMModel. For details, see "System DataModel" in theReferenceGuide.

l Virtual, System, andOther Properties
Properties holdingmetadata about artifact instances.

Properties may be one of the following:

Property Kind Description

Primitive Holds string, number, or boolean values. For example, name, description,
version. A primitive property is defined in DQL statements by the artifact type
name or alias, the property delimiter (. or $), followed by the property name. For
example, personArtifact.name. The artifact name or alias is optional (with the
delimiter) when the property is specific to a single artifact type in the query.

Complex Hold complex structures such as address. Only primitive sub-properties of
complex properties may be queried. Properties and sub-properties are separated
by . or $. For example, personArtifact.address.city.

Categorization Hold categorization data and are handled in a similar way to complex properties.
Categories consist of name, val, and taxonomyURI components. For example,
businessServiceArtifact.criticality.name.

Relationships Properties that specify a directional relationship to other artifacts.

All values that you can query are of a particular data type. The following table describes these data
types, and gives examples of how to use them in a query.

Data Type Description Example

Number Numeric values _revision = 1

String Text values _revisionCreator = 'admin'

Date Time Date and Time (ms since 00:00
1/1/1970)

_revisionTimestamp > 1274447040124

/* revisions made since 15:04 21/5/2010 */

Boolean True or False flags _deleted = '1'
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Properties may have the following cardinalities:

Property Cardinality Description

Single Only one instance of the property exists for an artifact and it may be
optional or required.

Multiple The property is a list of values and so occurs multiple times for an artifact.
InWHERE clauses, usingmultiple properties returns particular artifacts if
any instance of themultiple property matches the condition. In SELECT
clauses, usingmultiple properties returns all instances of themultiple
property as a concatenated, comma-separated string.

DQL uses the following system properties:

System Property Description

_artifactTypeName The human readable name of the artifact type (the SDM label of the
artifact). Micro Focus recommends using _sdmName in conditions, and _
artifactTypeName in SELECT clauses.

_category All categorizations for an artifact with name, val, and taxonomyURI
components.

_deleted The deletionmarker flag (boolean).

_id The database ID of an artifact instance (number, deprecated - use _uuid).

_longDescription Cloud Assessment supports a long description including HTML tags up to
25000 characters by default. Micro Focus recommends using the
description property in DQL queries instead as queries using _
longDescriptionmay affect performance and the HTML tags may corrupt
report outputs. description contains only the first 1024 text characters of
_longDescription (may vary according to your database type).

Note: The platform.repository.max.description.length property
determines themaximum length of _longDescription. You canmodify this
property in CloudAssessment_HOME/conf/setup/configuration-
propeties.xml. DB2 has an absolute limit of 32672 characters which is
sufficient for descriptions containing ASCII (single-byte encoding)
characters but may be exceeded, for example by Japanese descriptions,
leading to description truncation.

_owner The user, group, or role designated as the artifact owner.

_ownerName The human readable name of the user (taken from the use profile), group, or
role artifact.

_path Legacy REST path of the artifact (string, deprecated - use _uuid).

_relation A generic virtual property that may be used to specify all outgoing
relationships.
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System Property Description

_revision The revision number of an artifact instance.

_revisionCreator The user who created the revision of the artifact.

_revisionTimestamp The date and time the revision was created.

_sdmName The local name of the artifact type. Micro Focus recommends using _
sdmName in conditions, and _artifactTypeName in SELECT clauses.

_uuid The unique artifact identifier.

DQL uses the following virtual properties:

Property
Class

Property Description

UI
Property

_isFavorite Marked by the user as favorite flag (boolean).

_rating The average rating of the artifact (double).

Security
Property

_shared Indicates that the artifact is shared and visible to users in the
Sharing Principal role (boolean). For more details, see "How to
Share Artifacts" in theUser Guide.

_writable User write permission flag (boolean).
Note: Using this property may have a performance impact. If
possible, use thewritablemodifier instead. For details, see
Properties in DQL, on page 31.

Contract
Property

_enabledConsumer The artifact is a valid consumer artifact type.

_enabledProvider The artifact is a valid provider artifact type. The artifact must
also bemarked as 'Ready for Consumption'.

Domain
Property

_domainId Value of the domainId property defined for the domain artifact
that the artifact belongs to.

_domainName The readable name of the domain.

Lifecycle
Property

_currentStage Current working stage of an artifact.

_governanceProcess process applicable to the artifact.

_isApproved Lifecycle approval flag (boolean).

_lastApprovedRevision Revision number of the last approved revision (number).

_lastApprovedStage The name of the last approved stage.

_
lastApprovalTimestamp

Timestamp for the last approval (number, ms since 00:00
1/1/1970).

_lifecycleStatus The status of the current lifecycle stage.
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Policy
Manager
Property

_complianceStatus Compliance status as a percentage (number).

DQL and SQL
DQL supports most features of SQLwith the following exceptions:

l SELECT * is not supported.
l RIGHT and FULLOUTER JOIN are not supported.
l It is not possible to use properties with multiple cardinality in GROUP BY, HAVING, or ORDER BY
clauses.

DQL Grammar
A DQL query consists of the following elements with their grammar explained in the following sections:

l Select, on the next page
l FROMClause, on the next page
l Conditions, on page 36
l Expressions, on page 38
l Lexical Rules, on page 39
Typographical Conventions

Convention Example Description

KEYWORDS SELECT A reserved word in DQL (case-insensitive).

parsing rules expr Name of a parsing rule. A parsing defines a fragment of DQLwhich
consists of keywords, lexical rules, and other parsing rules.

LEXICAL
RULES

ID Name of a lexical rule. A lexical rule defines a fragment of DQLwhich
consists of letters, numbers, or special characters.

[ ] [ AS ] Optional content.

[ ... ] [ , select_
item, ... ]

Iterations of optional content.

| ASC |
DESC

Alternatives.

{ } { + | - } Group of alternatives.

.. 0..9 A range of allowable characters.
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Select

select :
subquery [ ORDER BY order_by_item [, order_by_item ...]]

subquery :
subquery [ set_operatorsubquery ...]
| (subquery)
| native_sql
| subquery_base

subquery_base :
SELECT [ DISTINCT ] select_item [, select_item ...]
FROM from_clause_list
[ WHERE condition ]
[ GROUP BY expression_list

[ HAVING condition ]
]

select_item :
expr [ [ AS ] alias ]

alias :
ID | QUOTED_ID

order_by_item :
expr [ ASC | DESC ]

set_operator :
UNION ALL | UNION | INTERSECT | EXCEPT

native_sql :
NATIVE [ (column_name [ column_type ] [ , ... ] ) ]
{ sql_select }

Explanation:

l The { } around the sql_select are required and sql_select is an SQL query.
l The column_name and column_type specify parameters to pass from the SQL query to the DQL
query.

FROM Clause

from_clause_list :
{ artifact_ref | subquery_ref | fixed_property | native_sql }
[ from_clause_item ... ]

from_clause_item :
, { artifact_ref | subquery_ref | fixed_property | native_sql }
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| [ LEFT [ OUTER ] ] JOIN
{ artifact_ref | subquery_ref } join_condition

artifact_ref :
artifact_name [ alias ] [ (artifact_modifiers) ]

subquery_ref :
(subquery)alias

fixed_property :
property_refalias

artifact_modifiers :
ID [ ,ID ... ]

artifact_name :
ID

join_condition :
| USINGproperty_ref

Conditions

condition :
condition_and [ OR condition_and ... ]

condition_and :
simple_condition [ AND simple_condition ... ]

simple_condition :
(condition)
| NOT simple_condition
| exists_condition
| like_condition
| null_condition
| in_condition
| simple_comparison_condition
| native_sql
| bind

simple_comparison_condition :
exprcomparison_opexpr

comparison_op :
= | <> | < | > | <= | >=

like_condition :
expr [ NOT ] LIKE like_expression [ ESCAPE
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STRING ]

like_expression :
STRING
| variable_ref

null_condition :
expr IS [ NOT ] NULL

in_condition :
expr [ NOT ] IN( { subquery | expression_list } )
| macro

exists_condition :
EXISTS(subquery)

bind :
BIND(property_ref [ , alias ] )

macro :
macro_name [ (expression_list) ]

macro_name :
#ID

Explanation:

l Conditions can be evaluated to true, false, or N/A. condition consists of one or more condition_and
that are connected by theOR logical operator.

l condition_and consists of one or more simple_condition connected by theAND
l simple_condition is one of following:

o condition in parentheses.
o Negation of simple_condition.
o exists_condition
o like_condition
o null_condition
o in_condition
o simple_comparison_condition
o native_sql

l simple_comparison_condition is a comparison of two expressions using one of the comparison
operators: =, <>, <, >, <=, >=

l like_condition compares an expression with a pattern. Patterns can contain wildcards:
o _means any character (including numbers and special characters).
o %means zero or more characters (including numbers and special characters).
o ESCAPE STRING is used to prefix _ and% in patterns that should represent those characters
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and not the wildcard.
l alias references the target artifact.

Expressions

expr :
term [ { + | - | CONCAT } term ... ]

term :
factor [ { * | / } factor ... ]

factor :
(select)
| (expr)
| { + | - } expr
| case_expression
| NUMBER
| STRING
| NULL
| function_call
| variable_ref
| property_ref
| native_sql

case_expression :
CASE case_item [ case_item ... ]

[ ELSE expr ]
END

case_item :
WHEN condition THEN

expr

function_call :
ID( [ DISTINCT ] { [ * ] | [ expression_list ] } )

property_ref :
{ ID | QUOTED_ID } [ { . | $ } { ID | QUOTED_ID } ... ]

expression_list :
expr [ ,expr ... ]

variable_ref :
? | :ID

Explanation:

l Variables are of two kinds:
o Positional variables - ? in DQL.
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o Named variables - :<name_of_variable>
l When variables are used in DQL, each variable must have a value bound to the variable.

Lexical Rules

CONCAT :
||

STRING :
[ N | n ] ' text '

NUMBER :
[ [ INT ] . ] INT

INT :
DIGIT [ DIGIT ... ]

DIGIT :
0..9

ID :
CHAR [ { CHAR | DIGIT } ... ]

CHAR :
a..z | A..Z | _

Explanation:

l ID is sequence of characters, numbers and underscores beginning with a character or underscore.
l QUOTED_ID is text in quotes.
l CONCATmeans a concatenation of strings - syntax ||

DQL with 3rd Party Products
DQL is provided by a JDBC driver which you can use with common SQL designers supporting 3rd-
party JDBC drivers (or ODBC with anODBC-JDBC bridge).

The following sections describe the driver and its use with third-party products:

l DQL JDBC Driver, below
l DQL in SQLDesigners, on page 41
l DQL inMS Access, on page 41

DQL JDBC Driver
The DQL JDBC driver translates DQL queries into SQL queries and executes them using the
underlying JDBC driver for the used database. The translation is provided by a remote invocation of
Micro Focus Cloud Assessment.
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All the required JAR files for the DQL driver are available in CloudAssessment_
HOME/client/lib/jdbc:

l pl-dql-jdbc.jar

l hessian-version.jar

l Database driver JAR files are copied here during installation (for example, ojdbc6.jar).
The following table describes the driver configuration required to use the driver with 3rd party products.

DQL JDBC Driver Configuration

Property Description

Connection
String

jdbc:systinet:http(s)://<username>@<host:port>/<context>[|schema=schema
name][|model=list of allowedmodels]
l <username> is the Cloud Assessment usernamewho executes the DQL query
using Cloud Assessment permissions security.

l <host:port> are the connection details of your Cloud Assessment installation
(for example, localhost:8080 for HTTP or secure:8443 for HTTPS.

l <context> is the application server context, the default is em.
l |schema=schema name is the schema of the user who owns Micro Focus Cloud
Assessment database tables. This parameter is optional. When omitted it is
supposed that the user account used to access the database is also the owner of
Micro Focus Cloud Assessment tables. In case a common user or read-only user
is used, use the power user schema name, unless the DQL JDBC Driver cannot
providemetadata regarding artifacts and properties.

l |model=list of allowedmodels is optional and represents a comma-separated
list of models. Only artifacts from allowedmodels are provided in JDBC metadata
as tables. The available models are sys and public. By default, only artifacts
from the public model are provided.

For example,
jdbc:systinet:http://admin@demoserver.acme.com:8080/soa|schema=SOA320

DB
Credentials

The database username and credentials used for direct access to theMicro Focus
Cloud Assessment database. In most cases it is the user who owns all tables for
Micro Focus Cloud Assessment - called the power user. In case of "Manual
Database Arrangement" with a power user and a common user (who has only
read/write access to tables, but can not create other tables), use the common user
account. In case the common user is still too powerful to be shared, the DB
administrator can create another - "read-only user" with read-only access toMicro
Focus Cloud Assessment tables. Note that the read-only user must also have
created synonyms/aliases for Micro Focus Cloud Assessment tables to pretend that
Micro Focus Cloud Assessment tables are in the schema of the read-only user. For
more details, see "Database Installation Types" in the Installation and Configuration
Guide.

DQL JDBC
Classname

com.microfocus.cloudassessment.dql.jdbc.DqlDriver
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NOTE:
NOTE: Note: The DQL JDBC driver must be able to connect to the database from the
client. Use the full hostname for your database used during installation or setup. In the
event of connection problems, verify the firewall settings between the local server and
the database server.

DQL in SQL Designers
SQLDesigner software can use the DQL driver if the designer is JDBC-aware.

To configure a JDBC-aware SQL Designer:

1. Add the DQL JDBC JAR files to the classpath.
2. Create a JDBC connection using the properties described in DQL JDBC Driver, on page 39.
After you establish the DQL JDBC connection, the following functionality should be available in your
SQLDesigner:

l Schema introspection, browsing the list of artifact types and property groups as tables, and their
properties as columns.

l DQL query execution.

DQL in MS Access
MS Access 2007 can execute DQL queries using anODBC-JDBC bridge. Before usingMS Access,
youmust configure the ODBC datasource inWindows.

To configure an ODBC-JDBC bridge:

1. Download and install an ODBC-JDBC bridge. For example, Easysoft ODBC-JDBC Gateway.
2. Configuration typically consists of:

l JDBC driver configuration using the properties described in DQL JDBC Driver, on page 39.
l Bridge configuration. For details, see the documentation for the bridge software.

DQL syntax varies from the examples given in Introduction to DQL, on page 23 in the following cases:

l Complex properties must use $ notation and be enclosed by [ ].
personArtifact.[address$addressLines$value], personArtifact.[address$country]

l To usemodifiers such as (include_deleted) use the Pass-Through option in MS Access.
l Left Joins do not work. Use plain joins instead.
l For fixed properties, use the Pass-Through option in MS Access.
l For timestamps, use the Pass-Through option in MS Access.
l Native queries do not work in MS Access.
l For property aliases, do not use quoted aliases.
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Chapter 6: Exploring the Database 
The functionality of Report Editor relies on interaction with the database.

This chapter describes how to examine and setup the database in the following sections:

l SDM to DatabaseMapping Tool , below
l Adding a JDBC Driver , below
l Changing the Data Collection Settings , on the next page
l Optimizing the Database , on the next page
l Writing SQLQueries , on the next page

SDM to Database Mapping Tool 
Artifacts in Cloud Assessment are stored in the form of XML documents. Their structure is defined by the
System DataModel (SDM). Artifacts are serialized into a database over a standard serialization layer. The
serialization of datamay differ from the norm, based on customer specific extensions or modifications.

The sdm2dbmap tool is amapping tool that generates a report containing themapping between your SDM and
database tables.

To generate the report, execute the following command:

CloudAssessment_HOME/lib/sdm/bin/sdm2dbmap

Themapping report is output to the following file:

CloudAssessment_HOME/lib/sdm/build/sdm2dbmap.html

The output consists of the following parts:

l A top level 1:1mapping between SDM artifacts and DB tables. Each artifact listed, maps directly to one
table.

l A list of artifacts. Each artifact in the report maps each SDM property to a specific column in the table.
There are also associated tables and foreign keys, joined using the primary key of the artifact table.

l A report documenting the DB schema for all database tables coming from the SDM. Tables with names
ending in _Rev are used to store older revisions.

Adding a JDBC Driver 
To connect to a database youmust specify a JDBC driver.

To add a JDBC driver:

1. In the Database Connections dialog box, click Manage Drivers.
TheManage JDBC Drivers dialog box opens.

2. Click Add to browse your filesystem for a driver.
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Micro Focus Software recommends using the same JDBC driver used during Cloud Assessment
installation.

3. Select the driver, and then click Open to add it to the list of drivers in theManage JDBC Drivers
dialog box.

Changing the Data Collection Settings 
By default, the editor limits the amount of data collected to 20 schemas and 100 tables in the Query
dialog box.

To change the data collection settings:

1. From themenu, selectWindows > Preferences.
2. ExpandReport Design > Data Set Editor, and then select JDBC Data Set.
3. Change the number of schemas and tables as required, and then click OK.

Optimizing the Database 
If you frequently use particular fields for joins in your queries, create an index for that field to improve
performance.

To create an Oracle index:

1. Log on to the sqlplus or isqlplus console as the system user.
2. Enter the following command:

create index ix_docrel_optimize2 on ry_docRel(sourceId, rtype);
As aminimum optimization, Micro Focus Software recommends the following:
l create index ix_res_optimize1 on ry_resource(fk_artifactType, m_deleted, id, m_path);
l create index ix_docrel_optimize2 on ry_docRel(sourceId, rtype);

Writing SQL Queries 
Although it is possible to use the query editor in Micro Focus Cloud Assessment Workbench, it is often
more convenient to use a specialized tool to develop queries.

This section describes some typical methods and provides examples to help you design your queries.

These examples were created using Oracle Developer for use with anOracle Database. Changes may
be required to use these queries with other database types.

This section contains the followingmethods and examples:

l Joining Tables in Queries , on the next page
l Example: Business Service SELECT , on the next page
l Example: Contract SELECT , on the next page
l Example: Combined Business Service and Contract SELECT , on page 45
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l Example: Accepted Contract Count for a Business Service , on page 46

Joining Tables in Queries 
To join tables in your queries, add the following to theWHERE clause of your SELECT statement:

l Key or foreign key condition
l Discriminator expression
l Check the deleted flag (0means false)
Example:

WHERE ryga_bsnService.id = rygt_ctgryPty.fk_resource_id
AND rygt_ctgryPty.discriminator = 'bsnPolicy_iBag'
AND bsnRes.m_deleted = '0'

Example: Business Service SELECT 
This example query returns details for business services that aremarked as ready for consumption:

Table ry_bsnService contains themain fields for business services.

Table >ry_resource contains general information about every artifact (for all artifact types).

The inner join to ry_resource in the FROM clause excludes deleted artifacts.

SELECT
bsn.id bsn_id,

bsn.name_val bsn_name,
bsnRes.m_path bsn_path,
bsn.serviceVersion_val bsn_version,
bsn.description_val bsn_description,
bsn.productionStage_name bsn_productionStage,

FROM ryga_bsnService bsn
INNER JOIN ry_resource bsnRes ON
(

bsnRes.id = bsn.id
AND bsnRes.m_deleted = '0'

)

WHERE bsn.readyForConsumption_val ='1'
ORDER BY lower(bsn.name_val)

Example: Contract SELECT 
This example query returns details for contracts that have been accepted:

SELECT
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contract.id ctrct_id,
contract.name_val ctrct_name,
contract.description_val ctrct_description,
contract.contractstate_name ctrct_state,
providerContractRel.targetpath ctrct_targetpath

FROM ry_contract contract
INNER JOIN ry_docrel providerContractRel ON
(

providerContractRel.rtype = '{http://systinet.com/

2005/05/soa/model/property}providerContractor'
AND providerContractRel.obsolete='0'
AND providerContractRel.deleted='0'
AND providerContractRel.targetDeleted='0'
AND providerContractRel.sourceId = contract.id

)
INNER JOIN ry_resource contractRes ON
(

contractRes.id =contract.id
AND contractRes.m_deleted='0'

)

WHERE contract.contractState_val =
'uddi:systinet.com:soa:model:taxonomies:contractAgreementStates:accepted'

Table ry_contract contains themain fields for contracts.

Table ry_docrel contains artifact relationship details.

The inner join to ry_docrel in the FROM clause excludes contracts where the provider-contract
relationship is obsolete, deleted, or where the provider does not exist.

Example: Combined Business Service and Contract
SELECT 
Example: Business Service SELECT , on the previous page and Example: Contract SELECT , on the
previous page can be combined to list the names of the contracts and the business service to which
they apply.

SELECT
contract.id ctrct_id,
contract.name_val ctrct_name,
bsn.id bsn_id,
bsn.name_val bsn_name

FROM ryga_bsnService bsn
INNER JOIN ry_resource bsnRes ON
(
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bsnRes.id = bsn.id
AND bsnRes.m_deleted = '0'

),
ry_contract contract
INNER JOIN ry_docrel providerContractRel ON
(

providerContractRel.rtype = '{http://systinet.com

/2005/05/soa/model/property}providerContractor'
AND providerContractRel.obsolete='0'
AND providerContractRel.deleted='0'
AND providerContractRel.targetDeleted='0'
AND providerContractRel.sourceId = contract.id

)
INNER JOIN ry_resource contractRes ON
(

contractRes.id =contract.id
AND contractRes.m_deleted='0'

)

WHERE bsn.readyForConsumption_val ='1'
AND contract.contractState_val =

'uddi:systinet.com:soa:model:taxonomies:contractAgreementStates:accepted'
AND providerContractRel.targetId = bsn.id

ORDER BY lower(bsn.name_val)

By merging the queries you create an n:1 relationship between contracts and business services.

Example: Accepted Contract Count for a Business Service 
This example returns business service details and the number of accepted contracts for each service:

SELECT
bsn.id bsn_id,

bsn.name_val bsn_name,
bsnRes.m_path bsn_path,
bsn.serviceVersion_val bsn_version,
bsn.description_val bsn_description,
bsn.productionStage_name bsn_productionStage,

( -- Contracts --
SELECT count (0)
FROM ry_contract contract

INNER JOIN ry_docrel providerContractRel ON
(

providerContractRel.rtype = '{http://systinet.com
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/2005/05/soa/model/property}providerContractor'
AND providerContractRel.obsolete='0'
AND providerContractRel.deleted='0'
AND providerContractRel.targetDeleted='0'
AND providerContractRel.sourceId = contract.id

)
INNER JOIN ry_resource contractRes ON

(
contractRes.id =contract.id
AND contractRes.m_deleted='0'

)
WHERE contract.contractState_val =

'uddi:systinet.com:soa:model:taxonomies:contractAgreementStates:accepted'
AND providerContractRel.targetId = bsn.id

) ctrct_count

FROM ryga_bsnService bsn
INNER JOIN ry_resource bsnRes ON
(

bsnRes.id = bsn.id
AND bsnRes.m_deleted = '0'

)

WHERE bsn.readyForConsumption_val ='1'
ORDER BY lower(bsn.name_val)
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Chapter 7: Deploying Reports 
When your report is ready, youmust deploy it to the Cloud Assessment server.

Report Editor offers twomethods:

l Deploy a report directly to the Cloud Assessment server.
For details, see Deploying a Report to Cloud Assessment , on the next page.

l Deploy a set of reports as an extension to the Cloud Assessment server.
This process consists of the following steps:
1. Creating a Reporting Extension , below
2. Applying Extensions , on page 50
3. Redeploying EAR File, on page 52

After deployment, you can access your report in various ways.

For details, see Accessing Reports , below.

You can remove custom reports from the Cloud Assessment server.

For details, see Removing Report Definitions from Cloud Assessment , on page 53.

Accessing Reports 
UseCases , on page 12 describes how Cloud Assessment uses specific functionality in the UI for each
report category.

It is also possible to directly access the reports in theMicro Focus Cloud Assessment server and obtain
alternative outputs.

In your browser, the following URLs use the Service Portfolio report as an example:

l https://hostname:port/cloudassessment/reporting/rest/reports/

l https://hostname:port/cloudassessment/reporting/rest/reports/service_
portfolio?alt=text/plain

l https://hostname:port/cloudassessment/reporting/rest/reports/service_
portfolio/documents/

l https://hostname:port/cloudassessment/reporting/rest/reports/service_
portfolio/documents/1/?alt=text/plain

The last URL is an instance of the report. The page source contains alternate URLs. Change the URL to
return a comma separated output of the report as follows:

l https://hostname:port/cloudassessment/reporting/rest/reports/service_
portfolio/documents/1/content?alt=text/csv

Creating a Reporting Extension 
You can also deploy a set of reports as an extension.
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To create a reporting extension:

1. In the Project Explorer, open the context menu for the project you want to deploy and select Cloud
Assessment>Build Extension.
The Build ExtensionWizard opens.

2. In the Build ExtensionWizard, input the parameters you require.
For parameter descriptions, see Build ExtensionWizard , on page 57.

3. Click Finish to create the extension.
Deploy the extension to the Cloud Assessment server using the Setup Tool.

For details, see Applying Extensions .

Deploying a Report to Cloud Assessment 
The Cloud Assessment plug-ins for Report Editor enable you to deploy your report directly to the Cloud
Assessment server.

To deploy a report to Cloud Assessment:

1. Make sure that the Cloud Assessment server is running.
2. In the Project Explorer or Navigator view, open the context menu for the report design you want to

deploy, and selectMicro Focus Cloud Assessment > Upload to Server.
You will be asked if you want to publish the default library. If you do not want to be asked again,
you can set this preference in the Preferencemenu of Report Editor.
ExpandWindow > Preferences > Micro Focus Cloud Assessment > Report Editor and
select whether you want Assertion Editor to prompt you every time you publish, always publish
the default library, or never publish the default library.

Custom Policy Manager reports do not containNotify functionality by default. To add this functionality
youmust add the report name to the notification context file.

To add notify functionality to custom PM reports:

1. Deploy your report to Micro Focus Cloud Assessment as described above.
2. Open CloudAssessment_HOME\deploy\microfocus-cloudassessment.ear\lib\pm-

persistence.jar\META-INF\pmNotificationContext.xml with a text editor.
3. Add a value element containing the report definition name to the file.

For example:

<bean id="pm-persistence.systemReportChecker"

class="com.microfocus.cloudassessment.policy.notification.SystemReportChecke
r">

<property name="reports">
<set>

<!-- Cloud Assessment system reports - report definition IDs -->
<value>acs_basic</value>
...

Report Editor
Chapter 7: Deploying Reports 

Cloud Assessment (1.01) Page 49 of 61



<value>MyTestReport</value>
</set>

</property>
</bean>

4. Save pmNotificationContext.xml.
5. Restart theMicro Focus Cloud Assessment server.

Applying Extensions 
You can extend Cloud Assessment by adding libraries or JSPs to the deployed EAR files, by modifying
the datamodel, by configuring the appearance of the UI, and by importing prepackaged data.

Extensions to Cloud Assessment come from the following sources:

l Customization Editor
Typical extensions created by Customization Editor contain modifications to the datamodel and
artifact appearance, and possibly data required by the customization (taxonomies). They may also
contain new web components, whichmay include custom JSP and Java code.
If your extension contains new artifact types, Cloud Assessment does not create default ACLs for
them. Set default ACLs for the new artifact types in Cloud Assessment. using the functionality
described in "How toManage Default Access Rights" in theAdministration Guide.

l Assertion Editor, Report Editor, and Taxonomy Editor
These extensions contain assertion, reporting, and taxonomy data only. They do not involve
changes to the datamodel.

The Setup Tool opens the EAR files, applies the extensions, and then repacks the EAR files.

Apply extensions according to one of the following scenarios:

l Single-Step Scenario , on page 52
The Setup Tool performs all the processes involved in applying extensions, including any database
alterations, as a single step.

l Decoupled DB Scenario , on the next page
Database SQL scripts are runmanually. The Setup Tool performs the other processes as individual
steps that are executable on demand. This scenario is useful in organizations where the user
applying extensions does not have the right to alter the database, which is done by a database
administrator.

CAUTION:
In some specific circumstances (underscores and numbers in property names), extension
applicationmay fail because Cloud Assessment cannot create short enough database table
names (31 character maximum for most databases).

The error in setup.log resembles the following:

[java] --- Nested Exception ---
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[java] java.lang.RuntimeException: cannot reduce length of identifier
'ry_c_es_Artifact02s_c_priEspPty01Group_c_priEspPty01',
rename identifier elements or improve the squeezing algorithm

[java] at com.cloudassessment.platform.rdbms.design.decomposition.naming.impl.
BlizzardNameProviderImpl.getUniqueLimitedLengthName(

BlizzardNameProviderImpl.java:432)
[java] at com.cloudassessment.platform.rdbms.design.decomposition.naming.impl.

BlizzardNameProviderImpl.filterTableName(BlizzardNameProviderImpl.java:374)

If you do not require backward compatibility with these older versions, you can change the table
naming algorithm.
To change the table naming algorithm:

1. Open CloudAssessment_HOME/lib/pl-repository-old.jar#META-
INF/rdbPlatformContext.xml with a text editor.

2. In the rdb-nameProvider bean element, edit the following property element:
<property name="platform250Compatible" value="false"/>

3. Save rdbPlatformContext.xml

CAUTION:
This solution only impacts properties with multiple cardinality. If the problem persists or
you need to preserve backward compatibility, then review the property naming
conventions in your extension.

Decoupled DB Scenario 
Follow this scenario if the user who applies extensions does not have permission tomodify the
database.

To apply extensions and modify the database separately:

1. Make sure that all extensions are in the following directory:
CloudAssessment_HOME/extensions

The Setup Tool automatically applies all extensions in that directory.
2. Stop the server.
3. Start the Setup Tool by executing the following command:

CloudAssessment_HOME/bin/setup -a.
4. Select theApply Extensions scenario, and click Next.
5. Click Next, to execute the extension application, and exit the Setup Tool.
6. Provide the scripts from CloudAssessment_HOME/sql to the database administrator.

The database administrator can use all.sql to execute the scripts that drop and recreate the
database schema.

7. Execute the Setup Tool in command-linemode to finish the extension application:
CloudAssessment_HOME/bin/setup -c

8. Redeploy the EAR file:
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The Setup Tool deploys the EAR file automatically.
If you need to deploy the EAR file to JBoss manually, see Redeploying EAR File, below.

Single-Step Scenario 
Follow this scenario if you have permission to alter the database used for Cloud Assessment.

To apply extensions to Cloud Assessment in a single step:

1. Make sure that all extensions are in the following directory:
CloudAssessment_HOME/extensions

The Setup Tool automatically applies all extensions in that directory.
If you are applying extensions to another server, substitute the relevant home directory for
CloudAssessment_HOME

2. Stop the server.
3. Start the Setup Tool by executing the following command:

CloudAssessment_HOME/bin/setup.bat(sh)
4. Select theApply Extensions scenario, and click Next.

The Setup Tool automatically validates the step by connecting to the server, copying the
extensions, andmerging the SDM configuration.

5. Click Next for each of the validation steps and the setup execution.
This process takes some time.

6. Click Finish to end the process.
7. Deploy the EAR file:

The Setup Tool deploys the EAR file automatically.
If you need to deploy the EAR file to JBoss manually, see Redeploying EAR File, below.

8. Restart the server.

CAUTION:
Applying an extension that modifies the SDMmodel may drop your full text indices.

CloudAssessment_HOME/log/setup.log contains the following line in these cases:

Could not apply alteration scripts, application will continue with slower DB
drop/create/restore scenario. ... .

In these cases, reapply full text indices. as described in the "Enabling Full Text Search" section
of theMicro Focus Cloud Assessment Installation and Deployment Guide.

Redeploying EAR File
After using the Setup Tool to apply extensions or updates, youmust redeploy the EAR file to the
application server. For JBoss, you can do this using the Setup Tool.

To redeploy the EAR file to JBoss:
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1. Stop the application server.
2. Start the Setup Tool by executing the following command:

CloudAssessment_HOME/bin/setup.bat(sh).
3. Select theAdvanced scenario, and click Next.
4. Scroll down, select Deployment, and then click Next.

When the Setup Tool validates the existence of the JBoss Deployment folder, click Next.
5. Click Finish to close the Setup Tool.
6. Restart the application server.

Removing Report Definitions from Cloud
Assessment 
You can remove custom report definitions from Cloud Assessment.

To remove a single report, use the context menu option.

To remove custom reporting extensions:

1. Remove any custom report extensions from CloudAssessment_HOME/extensions.
2. Execute the Setup Tool using the apply extensions scenario. as described, in "Setup Tool" in the

Micro Focus Cloud Assessment Administrator Guide.
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Chapter 8: Example: Failure Impact Report
for the Reports Tab 
To demonstrate the Reports Tab use case described in Use Cases , on page 12, follow this example:

To create a Failure Impact Report and add it to the a Reports Tab:

1. Create the failure impact report definition.
Follow the procedure described in Creating a Report Definition , on page 20 with the following inputs:

Parameter Definition

Name Failure Impact

Description Summary of Business Service Failure Impact Status

2. Create the Failure Impact data set.
For details, see Example: Failure Impact Data Set , below.

3. Create the Failure Impact Report layout.
For details, see Example: Failure Impact Report Layout , on the next page.

4. Deploy the Failure Impact Report to Cloud Assessment.
For details, see Deploying a Report to Cloud Assessment , on page 49.

5. Add the Failure Impact Report to the Cloud Assessment Reports Tab.
For details, see the "Custom Birt Reports" section of theMicro Focus Cloud Assessment User Guide.
Select Failure Impact from the list.

Example: Failure Impact Data Set 
To demonstrate the reporting tool use case described in Creating a Data Set , on page 21, follow this
example.

To create the Failure Impact data set:

1. Follow the procedure described in Creating a Data Set , on page 21 with the following inputs.
2. In the New Data Set dialog box, input the following parameters:

Parameter DQL Option SQL Option

Data Set Name Failure Impact

Data Source dqlDatabase Database

Data Set Type DQL Select Query SQL Select Query

3. Use the filter to only display the data that you want to use.
For SQL queries, all standard tables in Cloud Assessment begin with RYGA.
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4. Use Available Items to explore the data and identify the tables and columns you need for your
query.
For this report all the information required is for business services:
l For DQL, artifact type businessServiceArtifact.
l For SQL, tableRYGA_BSNSERVICE.

5. Construct your query by typing in the query input area and dragging and dropping items from
Available Items.
For this report the DQL query is:

select bs.criticality.name as "Failure Impact Status", count
(bs.criticality.name) as "No. of Services" from businessServiceArtifact bs
group by bs.criticality.name

For this report the SQL query is:

select RYGA_BSNSERVICE.CRITICALITY_NAME as "Failure Impact Status",
count(RYGA_BSNSERVICE.CRITICALITY_NAME) as "No of Services" from RYGA_
BSNSERVICE group by RYGA_BSNSERVICE.CRITICALITY_NAME

6. Click Finish to complete your query and view theOutput Columns for the data set.

7. Click Preview Results to view the actual data in your database.

8. Click OK and press Ctrl+S to save the data set as part of the report.

Example: Failure Impact Report Layout 
To demonstrate the reporting tool use case referred to in Designing a Report Layout , on page 22, follow
this example.

To Create the Layout of the Failure Impact Report:

1. In the failure_impact.rptdesign editor view, right-click and select Insert>Label.
2. Type the report heading Business Service Failure Impact Status.
3. Use the Property Editor view to change the format of the heading.

4. In a blank area of the failure_impact.rptdesign editor view, right-click and select Insert>Table.
5. Input the table parameters and select the data set. In this case, 2 columns and the Failure Impact

data set.
6. Select the left column header row, right-click and select Insert>Text. Input column header

Failure Impact Status, and then click OK. Repeat for the right column header, No of
Services.

7. In the Data Explorer, expandData Sets>Failure Impact.

Report Editor
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8. Drag Failure Impact Status from the Data Explorer to the left detail cell. Repeat forNo of
Services and the right detail cell.

9. In a blank area of the failure_impact.rptdesign view, right-click and select Insert>Chart to open
the New Chart dialog box.

10. This report requires a pie chart, select Pie Chart, and then click Next.

11. Under Select Data Set, select Use Data Set and Failure Impact from the drop-down list.
12. Drag Failure Impact Status from Data Preview to theCategory Definition input.
13. DragNo of Services from Data Preview to theSlice Size Definition input.

14. Click Next to format the chart appearance.
15. Select Chart Area, amendChart Title to Business Service Failure Impact Status, and

then click Finish to add the chart to the report definition.
16. Drag the chart area outline to the size you require, and then press Ctrl+S to save the report

definition.

17. Select thePreview tab to view the report with data from your data source.
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Appendix A: Dialog Boxes 
Each Report Editor input dialog is described in the following sections:

l Build ExtensionWizard , below. Creating a report extension.
l New Data Set , below Creating a new data set.
l New Report Project Wizard , on the next page Creating a new report project.

Build Extension Wizard 
Enter general parameters for the report extension.

Option Definition

Name The name of the reporting extension.

Description A description for the reporting extension.

Include library in
extension

Select this check-box if you want to include the default library in the
extension.

Folder The location of the reporting extensions folder.

Filename The filename of the reporting extension.

New Data Set 
Enter a name, then enter a source and type for the new data set.

Parameter Definition

Data Set
Name

Input a name for the data set.

Data
Source

Select the data source from the drop-down list. The selection of a DQL or SQL datasource
determines the exact query language required for your query.

Data Set
Type

Choose one of the options from the drop-down list:
l Select Query
l Stored Procedure Query
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New Report Project Wizard 
The New Report Project Wizard consists of the following stages depending on the options you select:

1. New Report Project Wizard: Default Library Configuration - Create a new data source , below
2. New Report Project Wizard: New Server , below

New Report Project Wizard: Default Library
Configuration - Create a new data source 
Configure the new data source and specify your login credentials.

Parameter Definition

Server URL The location of the Cloud Assessment server.

Server Username Your Cloud Assessment login.

Driver Class Automatically filled with the corresponding data base name on the
server.

Database Username and
Password

Your database credentials.

Database Schema The database schema name.

Manage Drivers Add, delete, or restore JAR files, and edit drivers.

Test Connection Test the server connection using the specified parameters.

New Report Project Wizard: New Server 
Create a new server for the project and optionally specify your authentication credentials.

Parameter Definition

Name The name of the server to display in the report editor.

URL The location of the Cloud Assessment server.

Username and Password Credentials for access to the Cloud Assessment server.

Save credentials Select to store the input credentials.

Validate connection Select to validate the server connection.

The Cloud Assessment server must be running to validate.
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Appendix B: Troubleshooting 
This appendix describes some common problems and their resolutions:

l Incomplete Table List , below
l The Platform Perspective is Missing Views , below
l The Report Result does not Appear , below
l Oracle Developer Queries Cause Errors in Cloud Assessment Workbench , on the next page
l SQLError on Report Previews , on the next page
l Cloud Assessment Workbench Looks Different from the Pictures in the Documentation , on the next page
l Cloud Assessment Workbench Displays Scrambled Table Names , on page 61

Incomplete Table List 
Problem

The list of tables is incomplete. Micro Focus Cloud Assessment Workbench limits the number of schemas
and tables accessed for performance reasons.

Solution

Change the settings, as described in Changing the Data Collection Settings , on page 43.

The Platform Perspective is Missing Views 
Problem

There are views missing from the Platform perspective. Themost likely reason for this is that some of the
views are closed.

Solution

Reset the perspective:

l From themenu, selectWindow > Reset Perspective.

The Report Result does not Appear 
Problem

The report result is not deployed to the Cloud Assessment server.

Solution

Check the report result:

1. In your browser, navigate to the latest report instance page. For example,
https://hostname:port/reporting/reports/service_
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portfolio/documents/1/?alt=text/plain.
2. Check the following status elements:

l <category label="finished"
scheme="urn:com:systinet:reporting:execution:status" term="finished"/>

l <category label="report document" scheme="urn:com:systinet:reporting:kind"
term="urn:com:systinet:reporting:kind:document"/>

A correctly finished report contains the finished value.
If the report execution does not finish, check the JMS settings, JMS queue, or the reporting service
logs to analyze the bottleneck.

Oracle Developer Queries Cause Errors in Cloud
Assessment Workbench 
Problem

Micro Focus Cloud Assessment Workbench returns errors for imported queries. Themost likely reason
is that your table names do not include the schema.

Solution

Include the schema name in the FROM clause of your query. For example, soadb.ry_docrel.

SQL Error on Report Previews 
Problem

When viewing the Preview page of a report, the following SQL error is shown:

ReportDesign (id = 1):
+ Cannot get the result set metadata.
SQL statement does not return a ResultSet object.
SQL error #1: Invalid column name ROWNUM

This error occurs because the Preview is not aware of the database type that the query is applicable to.

Solution

Check the database type parameter:

1. In the Preview page, click Show Report Parameters.
2. Verify that the database-type parameter matches the database you use.

Cloud Assessment Workbench Looks Different from
the Pictures in the Documentation 
Problem
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Micro Focus Cloud Assessment Workbench does not look exactly as depicted in the user
documentation. Themost likely reason for this disparity is that you are in the wrong perspective.

Solution

Switch to the Platform perspective:

l From themenu, selectWindow>Open Perspective>Platform.

Cloud Assessment Workbench Displays Scrambled
Table Names 
Problem

The tables names are unreadable. These aremost likely to be deleted tables stored in Oracle 10gR2.

Solution

Either change themaximum number of tables to 3000, as described in Changing the Data Collection
Settings , on page 43, or purge the deleted tables.

To purge deleted tables:

1. Log on to the sqlplus ot isqlplus console as the system user.
2. Enter the following commands:

l PURGE RECYCLEBIN
l PURGE DBA_RECYCLEBIN
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